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Overview
Welcome to the Autodesk Toxik 2009 Installation Guide for Linux. Toxik is Autodesk’s 
interactive solution for film compositing. It features a full High Dynamic Range (HDR) 
pipeline, next-generation 3D compositing, high performance interaction at extremely high 
resolutions and advanced rendering. It primarily features a databaseless workflow for data 
management, one Toxik seat, one scripting license, and unlimited rendering capabilities. 

The Toxik seat can be updated with extensions that add functionality to the product by the 
means of new tools and core fixes.

This edition of Toxik is supported on Linux 64 bit workstations. It uses Python® for scripting.

This guide explains how to install Toxik and its software components.

Audience
This document is intended for the person or artist that will be both installing and using the 
Toxik software.

To carry out the installation with ease, you should be familiar with network-ready software and 
network topology issues, license management technology, the Linux operating system, as well 
as the general principles of software installation.
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If you are not familiar with the above subjects, note that every effort has been made to ensure a 
smooth installation, whatever your level of experience. If you have difficulties, please contact 
Autodesk technical support.

Autodesk Toxik Components
A complete Toxik installation consists of a number of components.

Toxik Creative Application
The heart of Toxik is the creative application that permits the creation and playback of complex 
compositions, and supports manipulation of compositions in the media player itself.

Toxik License Server
The license server used in Toxik is FLEXnet™ 10.8.2.1. The license server keeps track of what 
components are running, and other licensing details. The license server only needs to be 
installed on one machine on the network. 

Toxik Scripting
Toxik scripting provides Python-based access to Toxik through a command-line interface. 
Scripting provides an effective means of loading plug-ins, browsing the database, managing 
users, projects, media and assets, and so on. It also provides direct access to more sophisticated 
Toxik internals, including control and renderer. Scripts can be saved and executed.

Toxik Configuration
You will install Toxik on one workstation only.

System Requirements
Toxik can be supported by various CPU Architectures and Operating Systems—see “System 
Requirements” on page 26. 

Playback speed in Toxik depends largely upon the ability of your local cache (attached storage) 
to deliver frame data at a high rate—see “Bandwidth Requirements” on page 28 and 
“Supported Graphics Cards” on page 27.
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File Requirements
There are two files you should download, the Release Notes, and the Toxik Creative Application 
file which also contains the License Server program.

• Autodesk Toxik 2009 Release Notes (pdf).

• Autodesk Toxik 2009 Installer for 64bit operating systems: Autodesk_Toxik_2009.tar.gz

Documentation and Training
Information and documents in PDFs are available at www.autodesk.com/toxik-documentation.

Accessing Online Help
Autodesk provides documentation in an HTML help system displayed in a Web browser. The 
help is automatically installed with the software.

To start help:

From the Toxik menu bar, choose Help >Toxik Help.

The Help appears in a browser window.

Release Notes
Release notes contain important information, including late-breaking information on 
Autodesk Toxik. Be sure to read the release notes before installing or using Toxik.

Documentation Conventions
The following conventions are used in this guide.

Document PDF Online Help

Autodesk Toxik 2009 Release Notes Yes No

Autodesk Toxik 2009 Installation Guide Yes No

Autodesk Toxik 2009 User’s Guide Yes Yes

Training Format

Autodesk Toxik New Feature Videos Macromedia Flash 

Notation Usage

# Indicates a command line to execute in a shell.

# cd /var/tmp/ora_inst Commands are written in courier bold.

http://www.autodesk.com/toxik-documentation.
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Contacting Technical Support
If you need more information, contact Technical Support at: www.autodesk.com/
subscriptionlogin.

/usr/src/redhat/SPECS/kernel-2.6.spec File names, URLs and directories are in italics.

<version#> Variables, such as system-specific information, are 
enclosed in angle brackets and written in courier 
italics.

Notation Usage

http://www.autodesk.com/subscriptionlogin
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Overview
This chapter describes what to do after you have downloaded and uncompressed the 
distribution files from the Autodesk Subscription Center.

NOTE: It will be helpful to have a utility on-hand to verify that the files downloaded without 

corruption. The distribution provides message digest (.md5) files for this purpose. 

Downloading the Distribution
When you purchase Toxik 2009, you will be advised either on your invoice or by email of your 
account user name and password, which will allow you to login to the Autodesk Subscription 
Center at www.autodesk.com/subscriptionlogin.

Once you have entered the Autodesk Subscription Center, you can download the Toxik 2009 
Creative Application (including the License Server program). You can store the uncompressed 
file in your /var/tmp directory as in the following example, or a directory of your choice.

To download the distribution from the Autodesk Subscription Center:

1. To access the Autodesk Subscription Center go to this link: www.autodesk.com/
subscriptionlogin.

2. Login to the Autodesk Subscription Center.
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3. Locate the Toxik application, download the distribution and save it in a temporary 
directory.

The distribution consists of the following files:

NOTE: Using an appropriate utility, ensure data integrity by creating an MD5 “checksum” for 

each downloaded file and compare it to the message digest value in the corresponding file 

provided.

4. Navigate to the temporary directory. 

cd /var/tmp, or cd to the directory in which you downloaded the files.

5. Uncompress the distribution files.

# tar -xzvf Autodesk_Toxik_2009.tar.gz

File Contents

Autodesk_Toxik_2009_64bit.tar.gz Interactive creative application where you create 
your compositions, and license server program.

.md5 files Message Digest files. Ensures the.zip files were 
not corrupted during the download.
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Overview
When you purchase Toxik your reseller or Autodesk Licensing Authority will provide you with 
your unique serial number. Before you can install Toxik, you must go online to obtain your 
Toxik license. Often the license server is installed on a dedicated machine that manages all your 
Autodesk licenses for your network. Autodesk Toxik uses Macrovision® FLEXnet™ 10.8.2.1 
licensing technology.

Requesting a License
Before you go online to the Autodesk site you will need to determine the computer name and 
hardware/MAC address of the workstation on which you will install the license server.

To determine the computer name and the hardware/Linux address:

1. Open a shell and type the following command to determine the License Server computer 
host name: 

# uname -a
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2. To determine the hardware/Linux address, issue the following command:

# ifconfig

The following information appears.

3. Make a note of the hardware/Linux address and close the shell.

To obtain your license file:

1. Using your web browser connect to http://register.autodesk.com, then create a User ID if 
you are a new user. Complete the fields by providing your contact information. Click Next.

2. On the Account Information page complete the fields with your contact information. Click 
Next.

3. On the Choose Account page the Select radio button is set by default for the account you 
have just created. Click Next.

a) Hardware/MAC address

a
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4. On the Product Registration & Activation page, Enter your unique serial number provided 
by your reseller or Autodesk Licensing Authority. Click Next.
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5. On the next Product Registration & Activation page Select Single Server, enter the Server 
Host name (Licence Server computer name), and the Server ID (hardware/MAC address). 
Click Next.



Requesting a License

   11

❚❘❘

6. On the next Product Registration & Activation page click Save License File.

NOTE: You also have the option to Print or Save Page. However, keep your license string in a 

safe place as you will need it to install or reinstall the license server. The Toxik Creative 

Application can be installed even if there is no license server, although the user will receive a 

warning that the license server is missing during installation.

7. A dialog box will open, the default setting is Save to Disk. Click OK.

NOTE: As an example we have save the license file to /var/tmp/

TOXIK2009enlicense.lic, however you may save the file to a location of your 

choice.
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8. You will return to the Product Registration & Activation page, if you don’t need to Register 
and activate more products, close the window.

9. If you have any licensing questions or issues, please address them as follows:

Installing the License Server
The license server tracks how many users are running Toxik. It must be installed before you 
install the Toxik 2009 application.

To install the license server:

1. Navigate to the temporary directory. 

cd /var/tmp, or cd to the directory in which you uncompressed the files.

2. Login as root, and run the setup file.

# su - root

# cd /var/tmp/Autodesk_License_Server_10.8.2.1_installer

#./setup.py

The software license agreement appears. 

Click ENTER until the last page appears. You must accept the terms of the agreement in order 
to continue with the installation. Type accept and press ENTER to continue.

3. You are prompted to enter the path to install the license server.

[ /usr/autodesk/Autodesk_License_Server ]

Press ENTER for the default path.

4. The installer validates the path, and you are prompted to install the software.

The default response is, YES, press ENTER.

5. The installer installs the software.

You are asked if you want to continue with the configuration. If yes, press ENTER. If not, see 
“Manually Configuring the License Server” on page 13.

In North America Outside North America

Hours Monday to Friday 8 a.m.–8 p.m. EST 
(excluding certain holidays).

Monday to Friday 8 a.m.–8 p.m. EST 
(excluding certain holidays).

Phone Toll-free: 1.800.925.6442 Direct dial: +1 514.954.7199

E-mail me.licensing@autodesk.com me.licensing@autodesk.com

Direct Line +1 514.954.7199

Licensing Fax +1 514.954.7254 +1 514.954.7254
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6. If you chose to continue with the configuration, you are prompted for the path to the license 
file.

The following command line gives an example of the path where we had saved the license 
file. Enter your path and press ENTER.

Example: /var/tmp/TOXIK2009enlicense.lic 

7. You are prompted for the name of the user who will run the license server. Press ENTER to 
accept autodesk as the user.If the name does not exist, you are prompted to create one. 
Press ENTER to accept.

NOTE: It is preferable that you enter “autodesk” as a user as this will only create a local user, not 

a network user.

8. You are asked if you want the installer to add the license server daemon to the system 
services and start it. Press ENTER.

The installation procedure has been completed.

Manually Configuring the License Server
You can manually configure the license server if you are using Red Hat Enterprise Linux WS 4.

To manually configure the license server:

Issue the following commands:

# su - root

#ln -s /usr/autodesk/Autodesk_License_Server/etc/lmgrd.init 

/etc/init.d/lmgrd

#cd /etc/init.d

#chkconfig --add lmgrd

#chkconfig --level 345 lmgrd on

Starting and Stopping the License Server
You can start and stop the license server if you need to update the license file.
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To start the license server:

Issue the following commands:

# su - root

#/etc/init.d/lmgrd start

To stop the license server: 

Issue the following commands:

# su - root

#/etc/init.d/lmgrd stop

NOTE: To view if the license server has correctly loaded the license token, open the log file: 

# more /usr/autodesk/Autodesk_License_Server/log/toxik.log

NOTE: lmgrd has been configured for init levels 3, 4, and 5.
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Overview
You are now ready to install the Toxik 2009 creative application. This chapter describes each 
stage of the installation. It begins by presenting some decisions you must make during the 
installation, and helps you prepare for configuring the software. Next, it presents the step-by-
step procedure for installing the software. 

Before You Begin
If you want high-performance playback, you will need to do the following:

• Add XFS file system support. 

• Format your media cache using XFS.

NOTE: Toxik has been tested with a media cache on a disk drive that uses EXT3 and XFS.

NOTE: You must have root privileges to install Toxik 2009.

Installing the Software
When you run the installation script, you are installing the Toxik Creative ApplicationToxik. 
This includes Toxikplug-ins (browsers, modules, tools and views), Python scripting, and fonts.
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Configuring the Media Cache
The media cache is another configuration you will be asked to perform during the install. This 
is the locally attached storage where images are stored when you import them, and to which 
intermediate results are written before being rendered and published. 

The media cache is managed by the operating system. Nevertheless, you must decide where the 
media cache will be located, and how large it will be (either in megabytes or as a percentage of 
the drive). For maximum speed, the media cache is usually local storage. In general, the larger 
the media cache the better, since it reduces the number of reads and writes to and from the 
external storage. For best results, locate the media cache on the local disk with the most 
available space.

NOTE: It is strongly recommended that the Autodesk Toxik media cache have a separate partition, 

and that the partition resides on a disk other that the operating system, ideally on a RAID device. 

For each minute of footage at 2K RGB using 16 bits @ 24fps depth, you will require 40 GB of media 

cache space. The Toxik media cache requires a minimum of 10 GB, while an optimal media cache 

size is suggested at 200GB. However depending on the project, you may want to consider a media 

cache size of 1 terabyte for a high-performance configuration. 

For information on the effect of the media cache on performance, see Appendix “Bandwidth 
Requirements” on page 28.

Installing Toxik
The Autodesk Toxik installer is automated and will quickly guide you through the process.

To install Toxik:

1. Navigate to the temporary directory. 

cd /var/tmp, or cd to the directory in which you uncompressed the files.

2. Log on as root, and start the installer.

# su - root

# cd /var/tmp/Autodesk_Toxik_2009_installer

# ./setup.py

The software license agreement appears. 

Click ENTER until the last page appears. You must accept the terms of the agreement in order 
to continue with the installation. Type accept and press ENTER to continue.
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3. You are prompted to enter the path to install Toxik.

[ /usr/autodesk/Autodesk_Toxik_2009 ]

Press ENTER for the default path.

NOTE: If you want to specify a different path, type the location, and press ENTER.

4. When the path is validated you are asked if you want to install. If you want to proceed, press 
ENTER.

5. Enter the path to the default HTML viewer. Select the default response:

[ /usr/bin/<HTML viewer>] and press ENTER.

6. Enter the name of the license server preceded with an ‘@’

@<license server name> and press ENTER

OR

 <port number>@<license server name> and press ENTER

NOTE: To see if the license server is reachable, issue the following command: 

# ping <machine name>

7. Enter the media cache location. Select the default response below or enter an alternate 
location:

[ /var/tmp/toxik/mediacache/ ] and press ENTER.

8. Enter the media cache’s size in megabytes (10240 minimum), or a media cache size factor 
followed by the percent sign (ex: 50%).

For maximum performance, you can allocate up to a maximum of 85% of disk space.

Enter the size and press ENTER to complete installation.

Changing System Limits on a Toxik Workstation
Finally, in order to have Toxik run properly, make sure you make the following changes. If you 
are unsure about the procedure, please contact your system administrator.
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To change the system limits on a Toxik workstation:

Issue the following commands:

# su - root

Add the following line at the end, after the #@student line:

# <your favorite text editor>/etc/security/limits.conf

# @student      -       maxlogins  4

*              soft    nofile     65536

*              hard    nofile     65536

# reboot or init 6

Once the machine has rebooted, login as root:

# su - root

# tcsh

# limit

Descriptors will be set at 65536.
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Starting Toxik . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Starting Toxik
Before you can do any work using the Toxik 2009 application, you’ll have to create either a new 
project, choose an existing project or open a recent project. For detailed information on using 
Toxik, refer to the Toxik 2009 User’s Guide in the online help.
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To start Toxik: 

1. Determine the type of shell you’re using: # echo $SHELL

2. If your shell is tcsh or csh: 

#source /usr/autodesk/Autodesk_Toxik_2009/bin/toxik-env.csh

# toxik

OR

If your shell is bash:

#source /usr/autodesk/Autodesk_Toxik_2009/bin/toxik-env.sh

# toxik

The Toxik screen appears.

3. In the Toxik screen, create a project, select an existing project, or open a recent project, and 
click Open.
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4. To check the software version and build number, select Help > About. 

The software version and build number should be Autodesk Toxik 2009 Build #2218.

5. To exit the software, select File > Exit or press CTRL+Q. 
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Overview
This chapter describes what to do, should you if you decide to uninstall the Toxik 2009 Creative 
Application and its components; Autodesk license server.

NOTE: If you already have another Autodesk product installed on your network that uses the same 

license management technology, you should not uninstall the Autodesk license server.

Uninstalling Toxik
Uninstalling Toxik 2009 removes all of the Autodesk Toxik 2009 files in the /usr/autodesk 
folder. It does not remove user and project preferences, projects, or compositions, or remove 
media. 

To uninstall Toxik:

1. Issue the following commands:

# su - root

# cd /usr/autodesk/Autodesk_Toxik_2009/etc

# ./uninstall.py

NOTE: You can also type the following to get more information:  ./uninstall.py -h

2. You are prompted to remove Autodesk Toxik 2009. Press ENTER.
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3. You are asked if you want to remove the whole directory structure. If you do, type Yes and 
press ENTER (No is the default).

NOTE: Modified files will also be deleted.

NOTE: You can consult the uninstall log at the following location: /var/tmp/txuninstall.log.

The Toxik 2009 Creative Application is uninstalled.

Uninstalling the License Server

To uninstall the license server:

1. Issue the following commands:

# su - root

# cd /usr/autodesk/Autodesk_License_Server/etc

# ./uninstall.py 

NOTE: You can also type the following to get more information:  ./uninstall.py -h

2. You are prompted to remove the license server. Press ENTER.

3. You are prompted to delete the user ‘autodesk’ that you created at installation. If you do, type 
Yes and press ENTER (No is the default).

4. You are prompted to stop and delete the service from /etc/init.d/lmgrd. Press ENTER.

5. You are asked if you want to remove the whole directory structure. If you do, type Yes and 
press ENTER. (No is the default).

NOTE: Modified files will also be deleted, including the license file.

NOTE: You can consult the uninstall log at the following location: /var/tmp/txuninstall.log.

The license server is now uninstalled.



   25

Appendix A

Summary
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

Supported Graphics Cards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Bandwidth Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42

Overview
Appendix A contains the Toxik 2009 system requirements, supported graphics cards and 
drivers, and bandwidth requirements, allowed by Toxik.
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System Requirements
Toxik can be supported with the following system requirements.

Playback speed in Toxik depends largely upon the ability of your local cache (attached storage) 
to deliver frame data at a high rate—see “Bandwidth Requirements” on page 42 and 
“Supported Graphics Cards” on page 41.

CPU Architecture

Operating System

Autodesk Toxik Creative and Render Requirements
• 1 GB RAM minimum or more

• CPU 64 bit processor minimum requirement should support 64 bit SSE3 (Streaming SIMD 
Extensions 3)

CPU Autodesk 
License 
Server

Autodesk 
Toxik

Intel® Pentium IV™ single or 
dual processor

o o

Intel® Xeon® EMT-64 single 
or dual processor

o o

Intel Core™ Solo o o

Intel Core 2 Duo o o

AMD Athlon™ 64 FX o o

AMD Athlon 64 X2 Dual Core o o

AMD Athlon Multi-core o o

OS Autodesk 
License 
Server

Autodesk 
Toxik

Windows Vista 32 bits o o

Windows Vista 64bits o o

Windows® XP Pro o o

Windows XP 64 bits o o

Red Hat Enterprise Linux 5, 
64 bits

o o

Red Hat Enterprise Linux 
WS4, Update 6, 64 bits

o o

Fedora 8, 64 bits o o
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• Supported graphics cards—see “Supported Graphics Cards” on page 41

• Three-button mouse or tablet

• Full keyboard

• Monitor with minimum resolution of 1600 x 1200 (recommended resolution 1920 x 1200)

• Network interface

• Media cache requirements:

– 10 GB minimum, 200 GB recommended

– HDD: IDE, SATA, SATA 2, SAS, SCSI

• 375 MB disk space for Autodesk Toxik Creative application

• Web browser with JavaScript and frames enabled (for viewing online help), Firefox is not 
supported as this creates errors when registering

• Adobe® Acrobat Reader (for viewing and printing documentation)

NOTE: Autodesk Toxik does not offer a network installation option.

Supported Graphics Cards
Toxik supports all the high-end Nvidia Quadro FX series graphic cards.

Graphics Card Windows Driver Linux Driver

NVIDIA Quadro FX5600 169.96 173.14.12

NVIDIA Quadro FX4600 169.96 173.14.12

NVIDIA Quadro FX4500 169.96 173.14.12

NVIDIA Quadro FX4400 169.96 173.14.12

NVIDIA Quadro FX4000 169.96 173.14.12

NVIDIA Quadro FX3700 169.96 173.14.12

NVIDIA Quadro FX3500 169.96 173.14.12

NVIDIA Quadro FX3450 169.96 173.14.12

NVIDIA Quadro FX3400 169.96 173.14.12

NVIDIA Quadro FX3000 169.96 173.14.12

NVIDIA Quadro FX2000 169.96 173.14.12

NVIDIA Quadro FX1400 169.96 173.14.12

NVIDIA Quadro FX1300 169.96 173.14.12

NVIDIA Quadro FX1100 169.96 173.14.12

NVIDIA Quadro FX1000 169.96 173.14.12

NVIDIA Quadro FX700 169.96 173.14.12
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Bandwidth Requirements
The following chart shows the bandwidth requirements in megabytes per second (MB/s) for 
playback of media of different formats. To ensure fast playback in Toxik, your attached storage, 
the local cache, must meet or exceed the bandwidth requirements of the desired format. 
Otherwise, Toxik will not receive the frames quickly enough. In the chart, “2K” refers to a full-
aperture film image; that is, a 2048 x 1556 pixel RGB image.

NOTE: Toxik only stores images at three different pixel depths: 8-bit (int), 16-bit (half-float) and 32-

bit (float). Any other formats are converted to the optimal format without losing any precision.

To calculate the bandwidth requirements for other formats, use the following formula:

For example, a “2K” 16-bit, 35mm Full Aperture 2K image results in the following calculation:

NVIDIA Quadro FX500 169.96 173.14.12

ATI Fire GL V3600 8.443.1 ---

ATI Fire GL V7350 8.443.1 ---

ATI Fire GL V5600 8.443.1 ---

ATI Fire GL V7600 8.443.1 ---

ATI Fire GL V8600 8.443.1 ---

Graphics Card Windows Driver Linux Driver

horizontal res. x vert res. x frames/second x channels/pixel x bytes/channel

1024 x 1024
Bandwidth (MB/second) =
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2048 x 1556 x 24 x 3x 2

1024 x 1024
Bandwidth (MB/second) =  = 437.63
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